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CHAPTER 1
Chapter 1

INTRODUCING LANTASTIC FOR WINDOWS 3.X

Welcome to LANtastic 8.0 _______________________________
Congratulations on your purchase of the LANtastic® 8.0 local area 
network software. To protect your current computer investment, 
LANtastic gives you complete DOS, Windows® 3.x, Windows 95/98 
and Windows NT 4.0 support. To learn about all of the features of 
LANtastic 8.0, see Chapter 1 of the LANtastic Installation and Setup 
Manual.

Finding the information you need_________________________
This manual provides instructions for day-to-day use and 
management of LANtastic for Windows 3.x.

LANtastic 8.0  manuals
You get these manuals with LANtastic 8.0:

■ LANtastic Installation and Setup Manual (printed)

■ LANtastic Troubleshooting Manual (Trouble.pdf)

■ LANtastic for DOS User’s Manual (Dos_um.pdf)

■ LANtastic for Windows 3.x User’s Manual (this manual)

■ LANtastic for Windows 95/98 User’s Manual (9x_um.pdf

■ LANtastic for Windows NT User’s Manual (L4nt_um.pdf)

LANtastic 8.0 Online Library
Your printed manuals are supplemented by the Online Library on 
the LANtastic 8.0 CD-ROM. This library includes comprehensive 
information about using LANtastic, whether you’re running 
Windows 3.x, Windows 95/98 or DOS. The Online Library presents 
information in Adobe™ Acrobat™ Portable Document Format 
(PDF) files. These files are convenient to view on your computer 
screen because they have Go to Page and Find functions. In many 
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cases, they also include hypertext links that allow you to jump 
quickly from place to place. And with book-page formatting, they’re 
easy to print and keep in a binder.

To view a file in the OnLine Library, follow the steps for installing 
the Adobe Acrobat reader in the LANtastic Installation and Setup 
Manual or in the Readme file. Instructions for navigating and 
printing PDF files appear there, too. 

Important… If you have LANtastic 8.0 on diskettes, you can obtain the 
information in these Online Library files in two ways:

■ From Artisoft’s FTP server (see your LANtastic Installation 
and Setup Manual for detailed information). All PDF-version 
files in the Online Library are available here.

■ From the LANtastic for Windows Online Manual, which is a 
part of your online Help system (see “LANtastic for Windows 
Online Manual” on page 2.

Topics covered in the Online Library files
The PDF files available on the CD and from electronic support 
services cover such topics as LANtastic’s DOS commands 
(Commd_dw.pdf) and LANtastic error messages (Errs_dw.pdf). The 
Windows section of the library also covers the following advanced 
network topics: SMB/NCP support (Clent_dw.pdf), indirect files 
(Indir_dw.pdf), IPX routable NETBIOS (Ipx_dw.pdf),LANcache 
(Lcach_dw.pdf), memory management features (Memry_dw.pdf), 
multiple adapters (Multi_dw.pdf), the NBSETUP program 
(Nbset_dw.pdf), NDIS driver support (Ndis_dw.pdf), LANCHECK 
(Lncheck.pdf) and remote booting (Rboot_dw.pdf). For a complete 
listing of the contents of the Online Library, see the LANtastic 
Installation and Setup Manual. 

Hint… If you’re new to computer networks, check the beginner’s guide to 
networking (Beginner.pdf) and the comprehensive glossary of terms 
(Glossary.pdf) in the Online Library.

LANtastic for Windows Online Manual 
If you need detailed information about LANtastic’s more advanced 
management features, you can use the LANtastic for Windows 
Online Manual instead of opening the PDF files described above, if 
you find it more convenient to use. All of the topics mentioned 
above are covered in the Online Manual.
LANTASTIC FOR WINDOWS 3.X USER’S MANUAL



3

The information in the Online Manual is intended for Windows and 
DOS users and is provided in an easily-searchable Windows 3.x 
Help system that’s accessible from the main LANtastic for Windows 
Help systems. To use the manual, run the LANtastic Net or 
Network Manager Help. Then click the green “jump” text at the 
bottom of the Contents page. 

LANtastic 8.0 Readme file
The Readme file contains instructions that became available after 
this manual, the Online Library and the online Help were 
completed. Read this file by clicking the Readme Viewer icon in the 
LANtastic program group. 

Using the online Help___________________________________  
If you pull down the Help menu in either the LANtastic Net or 
Network Manager window and select Quick Help, you’ll see an 
interactive window that pops up instant Help information on each 
part of the window you click, using the left mouse button. At any 
time when you’re using LANtastic, you can press F1 to see 
context-sensitive online Help. In addition to the Search, Back and 
History buttons, you can use the Browse Forward (>>) or Browse 
Backward (<<) buttons. 

Key words and phrases on many Help windows are highlighted in 
green. You can click these topics to jump to another window or to 
bring up a pop-up box containing more Help information. You can 
also view other Help windows by using the Search, Back, or History 
button at the top of each window. 

To learn how to perform a specific task, at the LANtastic Net 
Connections window or the LANtastic Network Manager window, 
choose How Do I? from the Help pull-down menu. You can also 
choose the How Do I? option from the Help Contents window. 
Scroll down the How Do I? topic list until you find the activity you 
want to learn about. 

You’ll see that the Help pull-down menu also includes a Quick 
Help option. Quick Help allows you to view brief explanations of 
each of the main functions on the LANtastic Net window or the 
LANtastic Network Manager window. 

To view the LANtastic for Windows Online Manual (see page 2), 
click the green “jump” text in the Net or Network Manager Help 
Contents window.

TIP…

You can browse through 
the Help before you start 
working with LANtastic. 
From the LANtastic Net 
or Network Manager 
windows, click the Help 
pull-down menu.
CHAPTER 1. INTRODUCING LANTASTIC FOR WINDOWS 3.X
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Note… If you’re not familiar with jumps, pop-up boxes and other features 
of Windows Help, you may want to take a short guided tour before 
you start working with LANtastic. To start your tour, select the 
Using Help option from the Help menu in the LANtastic Net or 
LANtastic Network Manager window.

Where to go for technical support ________________________
A variety of award-winning technical support services is available 
for Artisoft products. For complete instructions on using these 
services worldwide, see the Directory of Support Services that’s 
included in your package.
LANTASTIC FOR WINDOWS 3.X USER’S MANUAL



CHAPTER 2
Chapter 2

USING SHARED DRIVES 

Using the LANtastic Net window_____________________
The LANtastic Net window is your main tool 
for working with the LANtastic for Windows 
user interface.

To go to the LANtastic Net window, click the 
LANtastic Net icon in the LANtastic 
program group in Windows Program 
Manager. Some of the buttons in the 
LANtastic Net window bring up displays on 
which you drag and drop icons to make 
network connections. But if you prefer to 
work from a menu, go to the Net menu in 
the upper left corner of the LANtastic Net 
window. Click the menu title to pull down 
the list of options, then move the mouse 
pointer and click the option you want.

Most of the options on the Net menu are also available on the 
LANtastic pull-down menu in Windows File Manager. After you 
select an option and perform your operation, click anywhere on the 
File Manager screen to bring it back to the foreground. (If you make 
a computer or drive connection, select the Refresh All Windows 
option on the LANtastic menu after going back to File Manager. This 
makes your new connection appear on the File Manager screen.)

Hint… If you don't have a mouse, you can use the standard Windows 
keyboard conventions to select and choose options on any menu. 
5
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Making a new drive connection ______________________
You can connect to the disk drive of any computer that was set up 
for sharing during LANtastic software installation. Such a 
computer is called a server. Only a server can share its resources 
on the network. 

Note… For a practical example of the steps below, search for “Making a 
Drive Connection: an Easy Example” in the LANtastic Net Help.

1. From the LANtastic Net window, choose Drives. The Drive 
Connections window appears.

Note… If you’re in Windows File Manager, you can select the 
LANtastic pull-down menu to bring up the Drive Connections 
window.

The left pane of the Drive Connections window shows the 
names of the computers with drives that are available to 
connect to. The right pane shows your own drives (except for 
A:, B: and C:, these aren’t actual physical drives) and the 
connections that are already set up. There are also a number 
of available drive boxes that you can drag other computers’ 
drives into.

Hint… If you’ve already set up some drive connections and 
need to remind yourself what they are, complete step 1. 
Check the list in the right pane of the window, then click 
Close.

2. If the computer with the drive you’d like to use is listed in the 
left pane of the window, skip to step 4. If it isn’t listed: 

■ Click the Computers button at the top of the window. The 
Computer Connections window appears. 
LANTASTIC FOR WINDOWS 3.X USER’S MANUAL
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■ Select the desired computer from the list on the left:

■ If the computer that you want isn’t listed, type in its 
name in the Computer field and click the Connect 
button. (You’ll have to use this method to connect to 
servers running other networks, such as Novell 
NetWare, Windows for Workgroups and Windows NT.)

■ If the Connect to Computer window appears, type in 
your username and password and click OK. (This 
procedure is known as “logging in to” a server.)

■ Click Close.

3. At the Drive Connections window, drag the drive you want to 
use into an available drive box in the right pane of the window. 
You can also create a connection by highlighting the drive and 
drive box you’d like to use and clicking the Connect button. 

Hint… To cancel a drive connection, drag the drive icon out of the drive 
box in the right pane of the window. Alternatively, select the drive 
icon and click the Disconnect button.

4. Click Close. 

You can now start using your new drive connection. For 
instructions on doing this with File Manager, see “Using an existing 
drive connection” on page 8.

Making your drive connections permanent ___________  
Unless you make your drive connections permanent, the 
connections that you made in the previous section will disappear 
whenever you exit Windows or restart your computer. 

Hint… The steps here create permanent connections that are available 
only when you run Windows. To make permanent connections that 
will be available whether you’re running DOS only, or both DOS 
and Windows, use the SETNET command, as described in your 
LANtastic for DOS User’s Manual. 

1. Make a computer or drive connection as instructed in the 
previous section.

2. From the LANtastic Net window, choose the Options menu.

3. Choose Save Settings Now. 

4. If the Restore Settings on Startup option isn’t already 
checked, select that option now.
CHAPTER 2. USING SHARED DRIVES
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Using an existing drive connection____________________ 
When you turn on your computer, LANtastic automatically makes 
any computer and drive connections that you’ve already set up and 
made permanent, as described in the previous two sections. So if 
you want to use a file on another computer, all you have to do is go 
into File Manager or an application program and open the file.

Here’s how to use an existing drive connection using File Manager.

1. From the Main program group choose File Manager. The File 
Manager window appears.

2. Click the icons for your own drives or drives on other 
computers. Both types of drives behave the same. You can 
copy files between drives, double-click program files to run 
applications, and perform any other File Manager operations. 

Logging in and out of servers ________________________
If your network is set up to use LANtastic’s security features, you 
may need to log in to a server before you can use its drives. Logging 
in is the process of identifying yourself with a pre-assigned 
username and password. 

To log in to a server using the Computer Connections window, 
follow steps 1 - 3 under “Making a new drive connection” beginning 
on page 6. As you use your network, the Computer Connections 
window may appear at other times when you must select a 
computer. When this occurs, follow the same login procedures that 
are described beginning on page 6.

Drives on your
computer have
these types of

icons.

Drives on other
computers that

you’ve connected
to have this type

of icon.
LANTASTIC FOR WINDOWS 3.X USER’S MANUAL
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Note… To learn how to set up your computer so you can log in to more 
than ten servers at once, search for “Specifying the Number of 
Servers You Can Log in To” in the LANtastic Net online Help. To 
learn how to set up a server to allow more than five logins at a time, 
search for “Setting the Server Startup Parameters” in the LANtastic 
Network Manager online Help.

Sometimes you may receive a message that a server is shutting 
down, as described in the next section. When this occurs, you may 
want to log out of that server to avoid loss of data or other problems. 

To log out of a server:

1. From the Already Connected list in the Computer Connections 
window, click the computer you want to log out of. 

2. Click Disconnect. 

Shutting down your server __________________________
So far this chapter has focused on ways that you can use other 
people’s servers. But what if your computer is a server that other 
people frequently access – and you have to shut it down in the 
middle of a work day?

Before you reboot or turn off your computer, it’s a good idea to 
follow the guidelines in this section. That way, people who are 
using files on your disk won’t lose any work they haven’t saved. 

1. Exit Windows. 

2. At the DOS prompt, press Ctrl+Alt+Del. The Server Shutdown 
screen appears.

3. Check the Open Network Files field in the Server Shutdown 
screen: 

■ If the Server Shutdown screen shows zero files open, press 
S for Shutdown. Wait for the notification that shutdown is 
complete, then turn off your computer.

■ If the Server Shutdown screen shows one or more files open, 
check with your colleagues to see if they want you to keep 
your computer on until they’ve finished using your drive. 

■ If your LANtastic account has the S (System manager) 
privilege, you can schedule your server shutdown in 
advance and even send people a pop-up notification 
message. For more information, type NET HELP 
SHUTDOWN <Enter> at the DOS prompt. 

SEE ONLINE HELP…

For more detailed 
instructions on 
sharing disk drives, 
see the LANtastic 
Net Help. 
CHAPTER 2. USING SHARED DRIVES





CHAPTER 3
Chapter 3

USING SHARED PRINTERS

Making a new printer connection____________________
Hint… If you’ve already set up some printer connections and need to 

remind yourself what they are, complete steps 1 and 2 below. 
Check the list in the left pane of the Printer Connections window, 
then click Close. 

1. From the LANtastic Net window, choose Printers. The Printer 
Connections window appears.

Hint… IThe left pane of the Printer Connections window 
(Available for Connection) shows the names of the computers 
with printers that are available to connect to. The right pane 
(My Connections) shows your own printer ports and the 
connections that are already set up. There are also a number 
of available port boxes that you can drag other computers’ 
printers into. 

Note… A NetWare server’s printers won’t appear in the Printer 
Connections window. 

SEE ONLINE HELP…

If you’re in Windows 
File Manager, you 
can select the 
LANtastic pull-down 
menu to bring up the 
Printer Connections 
window.
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2. If the computer with the printer you’d like to use is listed in the 
left pane of the window, skip to step 4. If it isn’t listed: 

■ Click the Computers button at the top of the window. The 
Computer Connections window appears. 

■ Select the computer with the printer you’d like to use from 
the list on the left:

■ If the computer that you want isn’t listed, type in its 
name in the Computer field and click the Connect 
button. (You’ll have to use this method to connect to 
servers running other networks, such as Novell 
NetWare, Windows for Workgroups and Windows NT.)

■ If the Connect to Computer window appears, type in 
your username and password and click OK.

■ Click Close.

Note… To use a printer attached to a NetWare server, you 
must use the Specify button instead of the Computers button 
to specify the NetWare server and its resources.

3. At the Printer Connections window, drag the printer you want 
to use into an available port box in the right pane of the 
window. You can also create a connection by highlighting the 
printer and port box you’d like to use and clicking the 
Connect button.

Hint… To cancel a printer connection, drag the printer icon 
out of the port box in the right pane of the window. 
Alternatively, you can select the printer icon and click the 
Disconnect button.

4. Click Close. 

5. Make sure your Windows printer driver matches the type of 
printer you’re using. For instructions about setting up your 
computer to print under Windows, see “Setting up your 
computer for Windows printing” beginning on page 14.

You can now start using your new printer connection. For 
instructions on doing this, see “Using an existing printer 
connection” on page 13.
LANTASTIC FOR WINDOWS 3.X USER’S MANUAL
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Making your printer connections permanent _________  
The printer connections that you made in the previous section will 
disappear whenever you exit Windows or restart your computer. To 
make your connections permanent, so they appear every time you 
turn on your computer, follow the steps under “Making your drive 
connections permanent” on page 7.

Important… For each permanent printer connection that you make, be sure to 
follow the steps under “Setting up your computer for Windows 
printing” below.

Using an existing printer connection _________________  
When you turn on your computer, LANtastic automatically makes 
any computer and printer connections that you’ve already set up 
and made permanent, as described in the previous two sections. So 
if you want to use a printer on another computer, all you have to 
do is issue a print command from within a Windows 3.x and DOS 
application or from the DOS prompt. 

Here are the basic steps:

1. Run your application program. 

2. Open the file you want to print. 

3. Issue your application program’s print command.

Your job now goes to the port that was specified in the program’s 
print setup routine. It’s printed on the printer that you connected 
to that port using LANtastic. 

Hint… Suppose you regularly send jobs to a printer located in another 
office. Here’s how to minimize running back and forth. From the 
Options menu in the LANtastic Net window, select Print 
Notification. A check mark appears next to the option. LANtastic 
will now beep and send you a message whenever a job has finished 
printing.
CHAPTER 3. USING SHARED PRINTERS
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Setting up your computer for Windows printing _______
If you’re going to use a printer that’s attached to another computer 
– or if your own computer is a server and you want to use its 
attached network printer – you must perform these steps on your 
computer before you can print under Windows 3.x.

1. From the Windows Main group, choose Control Panel.

2. Choose Printers.

3. Make sure the Use Print Manager option is turned off. If the 
box is checked, click to disable it. 

4. Under the List of Printers, select the type of printer that’s 
attached to the server to which you’ve made your LANtastic 
printer connection. 

5. If you don’t see the server’s printer under the Installed 
Printers list, choose Add>> for a complete list of available 
printers. Select the printer that’s attached to the server and 
click Install. If you’re prompted to insert a Windows diskette, 
do so. Then follow the instructions on the screen. 

6. By default, Windows connects the selected printer to LPT1. If 
you want to change this connection, do so by performing 
steps 7 – 10.

7. Click the Connect button. 

8. From the list of ports, select the one into which you dragged 
the printer icon when you made your LANtastic printer 
connection. 

9. In the Timeouts (seconds) box, change Device Not Selected to 
900. Change Transmission Retry to 950. (Device Not Selected 
isn’t available if you’ve chosen a COM port.)

10. Be sure the Fast Printing Direct to Port option is turned off. If 
the box is checked, click to disable it.

11. Click OK.

12. If you want this printer to be the one to which all of your jobs 
are automatically sent, choose Set As Default Printer. The 
name of the default printer appears at the top of the window. 
Click Close.

13. Repeat steps 4 – 12 for each network printer to which you 
want to send jobs under Windows 3.x. 

14. Click Close and exit the Control Panel.
LANTASTIC FOR WINDOWS 3.X USER’S MANUAL
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Viewing and controlling print jobs ___________________  
When you send a job to a printer on another computer, the job 
waits in line until the printer becomes available. While it’s waiting, 
you can view the status of your print job or even cancel it. 

1. From the LANtastic Net window, click Jobs. 

2. If the Select Computer window appears, choose the name of 
the computer you sent the print job to and click OK. If the 
desired computer’s name isn’t listed, click the Connections 
button and follow the procedures under step 3 on page 12.

The My Print Jobs window appears, showing all the print jobs 
that you’ve sent to the selected computer. 

The My Print Jobs window shows you the sequence number, 
the printer to which the job was sent, the status of the job, 
the name of the computer the job came from, and any 
comment you included when you sent the file (usually this is 
the name of the file). The status of your print job can be 
Printing, Waiting, Held or Rush. For definitions of these 
designations, search for “Print Jobs Window Status Field” in 
the LANtastic Net online Help.

3. Select the print job you’d like to control and choose Detail, 
Delete, Hold, Release, Rush, or Contents. For definitions of 
these choices, search for “Print Jobs Window Options” in the 
LANtastic Net online Help.

4. When you’re finished, click Close.
CHAPTER 3. USING SHARED PRINTERS
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Viewing the All Jobs window
If you have the Q (Super Queue) or S account privilege, you can 
change the My Print Jobs window to the All Print Jobs window. 
This shows a list of everyone’s jobs that have been sent to this 
server. To do this, select the All Jobs option on the View menu.

If a server shares many printers and you want to look only at jobs 
intended for a specific one, open the Options menu and choose 
Printer Filter. Specify the names of the printers you want to see 
print jobs for. Note that if you’re using a printer attached to an SMB 
server, such as Windows for Workgroups or Windows NT, you can 
see all jobs, but you can control only those that you’ve sent. 

Using your own printer ______________________________
If you work at a server that shares its printer, you’ll have to send 
your own print jobs through the network. To do this, you need to 
make a LANtastic connection for your own printer as explained 
under “Making a new printer connection” on page 11. If you don’t 
do this, any print jobs that you send locally may not print correctly 
(or may not print at all) if a network print job is sent. 

Important… After you make a LANtastic connection to your own printer, be sure 
to follow the steps under “Setting up your computer for Windows 
printing” beginning on page 14.

If you don’t want to set up a network connection to your printer, 
but still want to print locally, halt your server’s printer queue as 
described under “Viewing and controlling print jobs” on page 15. 
To do this, you must have the Q (Super Queue) or S privilege. 
Alternatively, go to a DOS prompt and type NET UNUSE LPTn <Enter>, 
where n is the number of the LPT port being used by your printer. 
Your printer (LPTn) will now print only your own local jobs. 

Note… If you want to stop printing permanently and remove your server’s 
printers from the list of shared resources, disable the Printing 
Module in the Server Control Panel. For instructions see “Printing 
and Despooling Settings” in the LANtastic Network Manager online 
Help. 

SEE ONLINE HELP…

For more detailed 
instructions on 
sharing printers, see 
the LANtastic Net 
Help. 
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Chapter 4

USING LANTASTIC MAIL AND CHAT

Choosing a post office server ________________________
With LANtastic mail, everyone sends messages to one or more “post 
office” servers, where they’re stored in a resource called @MAIL. In 
order to read the messages, everyone logs in to the post office server 
and reads the messages that have been addressed to his or her 
account or machine name.

You can have only one mail resource per server, and it must be 
called @MAIL. Since LANtastic created a mail resource on each 
server during installation, you’ll have to create a new one only if 
you’ve deleted your mail resource. For instructions, search for 
“Creating a Mail Resource” in the LANtastic Network Manager 
online Help.

Important… You can send mail and chat messages among DOS, Windows 3.x, 
Windows 95/98 and Windows NT computers. All of them can get 
their mail from the same DOS or Windows post office server. (Note, 
however, that a Windows 95/98 or Windows NT server can’t 
function as a post office server.) 

Creating and sending a new message ________________
1. From the LANtastic Net window, choose Mail.

2. If this is the first time you’ve used Mail during this work 
session, the Select Computer window appears. Select the 
name of the post office server from the list and click OK. If its 
name doesn’t appear, click Connections and proceed as 
described in Chapter 2.

3. From the Mail menu, click Send.

4. Click Use Editor.

5. Type in your message.

6. Choose Send from the File menu.
17
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7. On the Select Recipients display, address the message as 
follows:

■ To send a message to an individual or ACL group, type in 
the account or computer name and click Send. If you don’t 
know the account or computer name, scroll though the list 
and select it. To select more than one name, hold down the 
Shift key as you click. When you’re finished addressing the 
message, click Send.

■ To send a global message to everyone on the network, type 
in an asterisk (*) and click Send. 

8. If desired, type in a comment (subject) and click Send.

Performing other mail functions______________________
1. From the LANtastic Net window, choose Mail.

■ If this is the first time you’ve used mail during this work 
session, the Select Computer window appears. Select 
the name of the post office server from the list and click 
OK. If its name doesn’t appear, click Connections and 
proceed as described in Chapter 2.

■ In the Incoming Mail box of the Mail window, you’ll see 
a list of the messages addressed to your account or 
computer name. The Outgoing Mail box shows 
messages you’ve sent to others. The mail envelope icons 
become darker as they wait longer in the mail queue.

■ By default, the Mail window updates itself every 21 
seconds. To change this, choose Options, then click 
Update Now or Update Rate. If you click Update Rate, 
drag the box to the desired setting, then click OK.

2. Select an item in the mail queue, then choose one of the 
buttons in the tool bar or options in the Mail menu. Here’s 
how to perform the various mail functions:

■ To read a message, click it.

■ To forward a message, select it and click Forward. 
Address it as described above, then click Send.

■ To delete a message, select it and click Delete.

■ To edit or print a message, save it as a text or 
application program file. You can then run that text 
editor or application and edit or print the message.
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Using Chat_________________________________________
LANtastic’s Chat feature allows two or more people to conduct a 
real-time, on-screen conversation.

1. From the LANtastic Net window, choose Chat. The Chat 
window appears.

2. Click the Call button, enter the account or computer name 
you’d like to call, then click OK.

3. A pop-up message informs the person on the computer you’re 
calling that you want to chat. To complete the connection, 
that person must choose the Go To Chat button. The Chat 
window then appears on his or her computer screen. 

Once you see the message <Connect> on your screen, the two 
of you can begin to type messages to each other. The field at 
the bottom of your screen shows the name of the computer 
you’re calling. 

4. Type in the message you want to send in the Local Machine 
field. The responses appear in the Remote Machine field. You 
may both type at the same time. If you type more text than 
will fit in the screen, the display scrolls up to give you more 
space. The options under the Edit menu allow you to copy 
text from the Chat window to the Windows 3.x clipboard, or 
paste text from the Windows clipboard to a Chat window. 

Hint… LANtastic Net allows you to have multiple Chat 
windows open and link the chat sessions together. Once this 
is done, the text you type appears in all the Chat windows 
you’ve linked. To use this feature, complete the steps above. 
In each Chat window, check the Link option in the Chat 
menu. The text you type now appears in the Remote Machine 
field of all the linked Chat windows. Other people can also 
link their Chat windows to create a conference call.

5. When you’ve finished chatting, click Hang Up to break your 
connection, then click Close. 

SEE ONLINE HELP…

For more detailed 
instructions on using 
Mail and Chat, see the 
LANtastic Net and Net 
Manager online Help. 
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Chapter 5

USING LOGIN ACCOUNTS FOR SECURITY

Using the LANtastic Network Manager window _______
The Network Manager window is your main tool for customizing 
LANtastic to fit your network needs. It works much the same as the 
LANtastic Net menu, which is explained in Chapter 2. In this 
chapter, you’ll use the Accounts button on the LANtastic Network 
Manager window to create a set of Login accounts.

About the default wildcard account __________________
During installation, LANtastic automatically created a wildcard 
account named “*” on every server. This default wildcard account 
allows up to 255 people on the LANtastic network to share all disk 
drives and printers on a server without typing in a username or 
password. This makes things easy if you aren’t concerned about 
network security. You can start sharing disk drives and printers as 
soon as LANtastic is installed without setting up any login 
accounts.
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The default “*” account comes with the S (System manager) 
account privilege that gives everyone the right to manage your 
network servers. To avoid unauthorized or inadvertent changes to 
your servers’ software settings, you may want to delete the wildcard 
account. Alternatively, you can give it special privileges that allow 
only certain people to perform network management activities. 

Note… If you opt to keep the default wildcard account and don’t want to 
set up any login accounts, go to the Server Control Panel and 
disable all options in the Security Control module except the 
Individual and Wildcard Accounts option. This frees up memory on 
the server. Instructions appear under “Setting the Server Startup 
Parameters” in the LANtastic Network Manager online Help.

About Login accounts________________________________
If you decide to keep the default wildcard account and don’t care 
about network security, you don’t have to create any login 
accounts. But if network security becomes important, you’ll want 
to create login accounts on every server. Once you’ve done this, 
only a person with a valid username and password can log in to a 
server. There are two types of login accounts:

An individual account allows an individual user to log in to a server. 
Whenever you log in, you’re prompted to type in your username 
and password (if a password has been set up for your account). 

A wildcard account allows multiple users to log in to a server using 
the same prefix. This makes it easy to create one set of accounts 
with a common set of features. For example, you might set up the 
wildcard account SALES-* for everyone in your sales department. 
Wildcard account names must end in an asterisk (*). To log in with 
a wildcard account, you simply add any name in place of the “*”.

Account security features ____________________________
Log-in accounts are security features in their own right, since they 
allow you to restrict the use of a server to people who have an 
authorized account on it. But once you’ve created a set of login 
accounts, you can use them as the basis for many other security 
features.
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For example:

■ Account privileges can be assigned to the accounts of the 
people who manage your network. These privileges will allow 
them to perform operations like monitoring print queues. 
Search for “Setting Privileges for an Account” in the 
LANtastic Network Manager online Help.

■ Access Control List (ACL) rights can be given to one or more 
individual accounts, wildcard accounts, ACL groups or 
templates. ACL rights give common access rights to a shared 
resource such as a disk drive or directory. Search the 
LANtastic Network Manager online Help for “Placing an 
Account in an ACL Group,” “Setting Access Control Lists for 
Drive Resources,” “Copying and Pasting Accounts and ACL 
Groups,” “Copying All Account and ACL Group Information,” 
and “Deleting an Account or ACL Group.” 

■ Expiration options can be added to an account. These include 
an account expiration date, a password expiration date and 
limited login hours. Search for “Setting an Account 
Expiration Date,” “Setting a Password Expiration Date” and 
“Setting Time-of-Day Logins” in the LANtastic Network 
Manager online Help.

■ The Disable Account option can be applied to an account if it 
won’t be used for an extended period, or if you’d like to deny 
access to a user or group. For instructions on disabling your 
own account, see “Changing your password and disabling 
your account” on page 28. For instructions on disabling 
someone else’s account, search for “Disabling a Login 
Account” in the LANtastic Network Manager online Help. 

■ The Broadcast Server ID to all Network Users option can be 
turned off, so a user must know a server’s name before he 
can log in. Search for “Setting the Server Startup 
Parameters” in the LANtastic Network Manager online Help. 

■ The Logins and Logouts options can be enabled, so people with 
the O (Operator) privilege will get pop-up messages whenever 
someone logs in or out of a server. Search for “Setting the 
Server Startup Parameters” in the LANtastic Network 
Manager online Help.

■ The Logins and Logouts auditing options can be enabled, so an 
entry is made in the server’s audit trail whenever someone 
logs in or out. Search for “Setting the Server Startup 
Parameters” in the LANtastic Network Manager online Help.

SEE ONLINE HELP…

You can browse through 
the Help to learn more 
about working with 
accounts. Double-click 
the Network Manager 
Help icon in the 
LANtastic program 
group. 
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How to create, modify and manage accounts__________ 
LANtastic gives you several ways to perform these activities on both 
accounts and ACL groups. For example, you can:

■ Create a separate set of accounts on each server. By this method, 
you go to each server and create a separate set of login 
accounts. See “Creating a new Login account” on page 25.

■ Create one set of accounts on a central account server to be shared 
by all your other servers.This makes maintaining individual, 
wildcard and ACL group accounts simple, because they’re all 
stored in one place. Search for “Setting Up a Central Account 
Server” in the LANtastic Network Manager online Help.

■ Copy and paste existing accounts to another server’s disk. Once 
you’ve created one set of accounts, you can copy them to 
another server and modify them as desired. Search for 
“Copying and Pasting Accounts and ACL groups” in the 
LANtastic Network Manager online Help.

■ Copy all the accounts on one server to a local control directory or 
to one on another server. This allows you to quickly set up the 
accounts for a new server, or back up the account 
information for a control directory. Search for “Copying All 
Account and ACL Group Information” in the LANtastic 
Network Manager online Help.

■ Export and import account files. After you’ve created your 
accounts, you can export the file to a text editor or database 
program. You can then copy and edit the account file and use 
it on multiple servers. Search for “Importing and Exporting 
Accounts Files” in the LANtastic Network Manager online Help.

■ Manage accounts using LANtastic Network Manager. You can 
change the name, password, privileges and other account 
parameters from LANtastic Network Manager. Click 
Accounts, select an account, click Edit and Modify. You can 
also disable and delete accounts. For extra convenience, you 
can manage accounts on remote servers from the keyboard 
of your own server. Search for “Controlling a Remote Server” 
in the LANtastic Net online Help.

■ Manage accounts using LANtastic Net. Anyone on the network 
can view the Account Status window using LANtastic Net. 
However, you must have an account with the Allow User 
Modify option enabled in order to change your password or 
disable your account. See “Managing an account with 
LANtastic Net” on page 27.
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Creating a new Login account _______________________
1. Check to make sure that the Individual and Wildcard 

Accounts option is enabled in the Server Control Panel of the 
LANtastic Network Manager program. If it isn’t, toggle this 
option to Enabled. Instructions appear in Chapter 7.

2. From the LANtastic Network Manager window, choose 
Accounts. The Accounts window appears. (If the Modify on 
Double-click option on the Options menu is enabled, you can 
also get to this window by clicking an account.) 

3. Specify the type of account you want to create. Definitions of 
individual and wildcard accounts appear on page 22.

■ To create an individual account, select the Individual 
Accounts icon, then open the Edit menu and click Add. 
The New Individual Account window appears. 

■ To set up a wildcard account, select the Wildcard 
Accounts icon, then open the Edit menu and click Add. 
The New Wildcard Account window appears.

If you’ve already created some wildcard accounts, click the 
Wildcard Accounts icon. You must then place the selection 
bar on the account you’d like the new account to appear 
before. The order in which you place the wildcard 
accounts is important. For guidelines, see “Placement 
order of wildcard accounts” on page 26.

4. Enter the account name and description. Click Set Password 
if you want to require a password for logins with this account. 
You must then type in a password. 

5. If you want to create the account but not enable it yet, click 
in the Enabled box so it isn’t checked.
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6. In the Concurrent Logins field, enter the number of people 
that you’d like to allow to log in to this server at once. For 
wildcard accounts, allow at least one concurrent login for 
each user who’ll log in using that account. For individual 
accounts, you may want to add extra logins to let the user 
access the server from more than one computer. 

7. Click OK.

Note… The Allow User to Modify Account option lets you allow or disallow a 
user or group member to change her password or disable her account. 
To use it, go to the Accounts window and click Edit, then Modify.

Placement order of wildcard accounts
If you haven’t deleted LANtastic’s default wildcard account, always 
select it first when you’re determining the placement order of your 
other wildcard accounts. This ensures that the “*” account stays at 
the bottom of the list. This is important because when a person 
attempts to log in, the server scans the list from top to bottom and 
uses the first match it finds. Since the “*” account matches any 
username, LANtastic ignores any wildcard accounts listed after it.

You must also make sure that any other wildcard account names 
appear below those of matching entries in the list. For example, an 
entry called S* listed above SALES-* would match the username 
SALES-JOEL and any other accounts that begin with the letter S. 
To place a wildcard account at the bottom of the list, select the 
empty position at the end of it, then create the account. If you place 
the selection bar on a wildcard account, the new account will be 
placed before the original highlighted account. 

Deleting an account or ACL group ____________________
1. From the LANtastic Network Manager window, choose 

Accounts. 

2. Select the desired individual account, wildcard account, ACL 
group or ACL group member.

■ To delete all the individual or wildcard accounts, select the 
Individual Accounts or Wildcard Accounts icon.

■ To remove a member from an ACL group, click the ACL 
group’s icon and select the desired member.

■ To delete an entire ACL group, select the group’s icon.

3. Open the Edit menu and click Delete. 
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Managing an account with LANtastic Net ____________
LANtastic Net includes options that let users manage their own 
accounts. While they can’t create or delete accounts, they can 
check their account status and privileges, change their passwords 
and disable their accounts.

Checking your account status
1. From the LANtastic Net main window, choose Account. 

The first time you use a network option, you’re prompted to 
select a server. If you’re not already connected to the server 
you want, choose the Connections button and log in as 
instructed in Chapter 2. Click OK. The Account Management 
window appears.

2. If you’d like to see the Account Management window for a 
different server, choose Computers, select a name from the 
list and choose OK. If you want to select a server that doesn’t 
appear on the list, choose the Connections button and log in 
as instructed in Chapter 2.

The Account Management window gives you detailed 
information about your account, including your username, 
your account privileges (if any), and any expiration 
restrictions it may have.
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Changing your password and disabling your account
To perform these operations, you must have an account with the 
Allow User to Modify Account option enabled. 

1. From the LANtastic Net window, choose Accounts. 

2. If you’re prompted to select a server or if the selected server 
isn’t the one with the account you want to modify, refer to 
steps 1 and 2 in the previous section. 

3. From the Account Management window, perform one of these 
functions:

■ Click Password and type in your old password. Then 
type in the new password and click OK.

■ Click Disable, type in your password and click OK. 

CAUTION! To re-enable your account, you must have 
adequate privileges on the server concerned. To 
re-enable it, go to the server and from Network Manager, 
choose Accounts. Select your account, open the Edit 
menu and choose Modify. Click the Account Enabled 
box to turn the option back on, then click OK.

SEE ONLINE HELP…

For more detailed 
instructions on 
working with 
accounts, see the 
LANtastic Network 
Manager online Help. 
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SETTING UP SHARED RESOURCES

About shared resources _____________________________
Shared resources are the disk drives, CD-ROM drives, printers, 
and other devices attached to a server. All of these devices have the 
potential of being shared on the network. You just have to give 
them a network name, so LANtastic can identify them and make 
connections among them. Giving a device a network name is 
known as “creating a shared resource.”

When you installed the LANtastic software, a printer resource 
named @PRINTER was automatically created on each server. A 
named resource was also created for every hard disk, floppy drive, 
disk partition and CD-ROM that LANtastic detected. 

To see a list of these default shared resources, choose Resources 
from the LANtastic Network Manager window. Each shared resource 
in the list has the same name that it uses on your system – for 
example, C-DRIVE. For a typical list of shared resources, see the 
Resources window shown under “Creating a shared drive or 
directory resource” on page 31.

If the default resources listed in the server’s Resources window are 
all you want to share on the network, you don’t have to create any 
more resources. However, if you want to limit access to certain 
directories on the server’s hard disk, you’ll need to use LANtastic 
to set up each directory as a separately named shared resource. 
You’ll also have to set up a new resource if you buy a new printer 
or CD-ROM drive that you want to share, or if a server has more 
than one printer attached.

Resource security features ___________________________
Shared resources can be security features in their own right, since 
you can give them access restrictions that allow only authorized 
people to use them in designated ways.
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For example:

■ Access Control List (ACL) rights can be assigned to one or more 
login accounts that use the resource. ACL rights give 
common access rights to a shared resource such as a disk 
drive or directory. Search for “Setting ACL Rights for a Drive 
Resource,” “Placing an Account in an Existing ACL Group” 
and “Working with ACL Templates” in the LANtastic Network 
Manager online Help. 

■ Secure directories can be created to organize a drive resource 
into areas containing data files and shared applications. 
Search for “Planning Your Drive Resources” in the LANtastic 
Network Manager online Help.

■ File-level security can be set up to restrict access to an 
individual file within a shared drive resource. Search for 
“Setting File-Level Security” in the LANtastic Network 
Manager online Help. 

■ Control directory protection can be set up by restricting access 
to any resource that contains a control directory. 

Important… Security rights on a disk resource are applied downward through 
the entire directory. For example, if you define C-DRIVE as pointing 
to C:\ and give full rights to that resource, a person keeps those 
rights at all levels within that drive – unless file-level security is 
applied.

Resource and ACL shortcuts __________________________
When you’re creating shared resources and ACLs, you can save 
time with a few simple tricks. For example, you can:

■ Copy the information from an existing resource and paste it to 
create another one. Search for “Copying Resources” in the 
LANtastic Network Manager online Help.

■ Copy and paste an ACL to any shared resource. For example, 
you can copy an ACL to a resource in another control 
directory – even it’s located on another server. Search for 
“Copying and Pasting an ACL” in the LANtastic Network 
Manager online Help.

■ Create an ACL template that allows you to set access rights for 
an entire group of users. Search for “Working with ACL 
Templates” in the LANtastic Network Manager online Help.
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Creating a shared drive or directory resource _________  
1. From the LANtastic Network Manager window, choose 

Resources. A window similar to the one shown appears. 

2. Open the Edit menu and choose Add, or press Ins.

3. Select Shared Drive. Make sure the Local Resource option is 
selected. 

4. Type in the name of the new drive resource in the Resource 
Name field. The name must follow DOS conventions for 
naming a file. It can be up to eight characters long, with a 
three-character extension.

5. If desired, type in a description (up to 64 characters) for the 
new drive resource.

6. In the Local Path field, type in the actual local path for this 
resource on the server. For example, to set up your C: drive 
as a shared resource you’d type C: or to set up your C:\APPS 
directory as a shared resource you’d type C:\APPS.

7. Click Icon to bring up a window that shows you the shared 
drive resource icons available. Select an appropriate icon for 
the new resource and click OK. This is the icon that users 
will see in the window when they attempt to connect a local 
drive to this shared resource.

8. Click OK. The new resource now appears on the list of shared 
resources for that server.
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Creating a shared printer resource____________________
This section tells you how to set up a single printer resource. To set 
up a printer pool resource, search for “Creating a Printer Pool 
Resource” in the LANtastic Network Manager online Help.

1. From the LANtastic Network Manager window, click 
Resources.

2. Open the Edit menu and click Add.

3. Click Shared Device from the Resource Type field and type in 
the name for the new resource. An “@” sign must precede the 
name. The name, including the “@” sign, may be up to eight 
characters long and include a three-character extension. For 
example, @PRINTER.PRN.

4. Click Icon to bring up a window that shows you the available 
printer resource icons. Select an appropriate icon for the 
new resource. This is the icon that users will see in the 
Printer Connections window when they attempt to connect a 
local printer port to this device. Click OK.

5. Make sure the Local Resource option is selected. 

6. If you like, type in a description for the new resource.

7. Click Device.

■ If the printer is attached to this network server, select the 
port in the Spooled Device section where the printer is 
attached and click OK. Generally this will be an LPT or a 
COM port. 

■ If you’ll be using the LANtastic Remote Print Server 
program (RPS.EXE) to pull print jobs from the server’s 
queue and send them to other printers on the network, 
select Remote and click OK. 

■ If you’re creating this resource for use with an HP® 
JetDirect™ printer, choose HP JetDirect, enter the 
requested information, and click OK.

■ If you’re creating this resource for use with a printer 
attached to a Central Station, choose CSPrint, enter the 
requested information, and click OK.

The new printer resource now appears on the list of shared 
resources.
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8. Click OK. The resource is now created. If you want to specify 
print parameters, complete the steps below.

■ Open the Edit menu and click Modify. The Resource 
Parameters window appears. For descriptions of the 
options in the Resource Parameters window, search for 
“Options in the Resource Parameters Window” in the 
LANtastic Network Manager online Help.

■ If you selected a COM port as the output device, click the 
Serial Device Parameters option in the Resource 
Parameters window. For descriptions of the options in the 
Serial Device Parameters window, search for “Options in 
the Serial Device Parameters Window” in the LANtastic 
Network Manager online Help.

■ Set the parameters to the correct configuration for your 
printer, then click OK. Consult your printer manual for 
information.

■ If you selected Remote, HP JetDirect or CSPrint, go to the 
Server Control Panel window in LANtastic Network 
Manager and enable the corresponding support option 
under Printing and Despooling.

9. Shut down and restart your server.

■ Follow the instructions under “Shutting down your 
server”that begin on page 9.

■ To restart the SERVER program, go to the DOS prompt 
and type SERVER <Enter>. This makes your new resource 
available for sharing.

After you’ve created your new printer resource, go to each 
computer that will regularly use the new printer and make a new 
permanent printer connection. See “Adding or removing a printer” 
on page 55.

Important… In order to send jobs to an HP JetDirect printer resource, you must 
have an NDIS driver for the network adapter in your computer. 
Instructions for checking your adapter driver and performing other 
steps to add a new HP JetDirect printer appear in the LANtastic 
Installation and Setup Manual.
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Printer initialization strings and files __________________
The printer setup string lets you specify a group of control 
characters to initialize a printer for a specific mode of printing. 
Consult your printer manual for the character options for your 
printer. For instructions on creating a printer setup string, search 
for “Using the Printer Setup String” in the LANtastic Network 
Manager online Help. 

Setup and cleanup files allow you to include more control codes than 
the 64-character limit for the printer setup string. First the setup 
file initializes the printer for a specific mode of printing. After the 
job is printed, the cleanup file resets the printer, usually to its 
original mode of printing. For instructions, see “Using Setup and 
Cleanup files” in the LANtastic Network Manager online Help.

Creating other types of shared resources _____________
In addition to resources for drives and printers, LANtastic allows 
you to create several other types of shared resources. For example:

■ A printer pool resource consists of a list of printers. Instead of 
waiting in a line for a single printer, your jobs are printed on 
the first available printer in the pool. Search for “Creating a 
Printer Pool Resource” in the LANtastic Network Manager 
online Help.

■ A global resource is defined on one server but points to remote 
resources that physically exist on another server. That way 
users can log in to only one server to use multiple servers’ 
resources. Search for “Creating Global Drive Resources” in 
the LANtastic Network Manager online Help.

■ A mail resource allows you to send e-mail across the network. 
Although LANtastic created a mail resource on each server 
during installation, you’ll have to create a new one if you’ve 
deleted your mail resource. Search for “Creating a Mail 
Resource” in the LANtastic Network Manager online Help.

■ A shared keyboard or screen resource allows you to view a 
remote server’s screen from your own computer and send 
commands to be run on that server. Although LANtastic 
created a shared keyboard and screen resource for each 
computer during installation, you’ll need to create new ones 
if you’ve deleted these resources. Search for “Creating 
Keyboard and Screen Resources” in the LANtastic Network 
Manager online Help.

SEE ONLINE HELP…

For more detailed 
instructions on 
working with shared 
resources, see the 
LANtastic Network 
Manager online Help. 
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■ A spooled keyboard resource allows you to send a server a 
batch file that will be executed at a time you specify. 
Although LANtastic created a spooled keyboard resource for 
each computer during installation, you’ll need to create a 
new one if you’ve deleted this resource. Search for “Creating 
Spooled Keyboard Resources” in the LANtastic Network 
Manager online Help.

■ A CD-ROM or other non-DOS drive resource will be necessary if 
you attach a CD-ROM after installing LANtastic, or if you 
want to share a WORM or other type of non-DOS drive. 
Search for “Creating a CD-ROM or Other Non-DOS Drive 
Resource” in the LANtastic Network Manager online Help. 
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SETTING UP AND MANAGING YOUR SERVERS

Setting parameters in the Server Control Panel________
The Server Control Panel allows you to “turn off” the sharing 
functions that you don’t need on each computer. For example, if 
only one of your computers has a printer, you can turn off the 
Printing module on all of your other computers, saving valuable 
application memory. You can also use the Server Control Panel to 
fine-tune server performance and set up security features. 

1. From the LANtastic Network Manager window, choose Server.

2. You’ll be prompted to specify the path to the copy of 
SERVER.EXE that your computer uses. Usually this will be 
C:\LANTASTI\SERVER.EXE. The Server Control Panel 
appears.

3. Enable the server modules you’d like the server to use by 
dragging them from the Available Modules list into the 
Configured Modules list. Your current server memory usage 
appears to the right of each module in the Size field.

Hint… To make server configuration easy, click the down arrow next to the 
Total Memory field and choose one of the server personalities from 
the scroll-down list that appears. 
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Exit Windows and press Ctrl+Alt+Del at the DOS prompt. In the 
screen that appears, make certain that there are no open network 
files and press S. The parameters you set are used the next time 
you run LANtastic on this server.

Hint… You can view multiple servers’ software settings by opening the File 
menu, choosing Open Server and specifying the path to another 
server’s control directory. For convenience, the last few servers on 
which you’ve adjusted settings are listed in a menu in the upper left 
corner of the Server Control Panel.

Modules in the Server Control Panel
Here are descriptions of the Server Control Panel modules. For 
detailed descriptions of the options within each module, search for 
the name of each module (for example, “General Server Attributes”) 
in the LANtastic Network Manager online Help.

Important… To ensure that unauthorized people don’t change the parameters 
in the Server Control Panel, create a password for the control 
directory. Search for “Password-Protecting a Control Directory” in 
the LANtastic Network Manager online Help.

General Server 
Attributes

Sets the maximum number of users that can access the 
server, the number of network adapters installed in the 
computer, the number of open files the server can support, 
the type of memory that LANtastic’s file system features will 
use, and advanced options. This module can’t be disabled. 
Note: For more information about the file system memory 
option, see the next section.

Server 
Performance

Sets performance options such as the network buffer size 
and the number of simultaneous tasks the server can 
perform for network users.

Printing and 
Despooling

Sets options such as the number of shared printers that 
network users can simultaneously print to and the size of the 
printer buffers used. Also lets you manage direct network 
printing (such as HP JetDirect and Central Station). 

Security Control Enables server security functions such as sending the server’s 
name to network computers, user accounts and Access 
Control Lists. 

Server Auditing Sets up a log of server events you want audited such as 
when users log in or are denied access to a shared drive or 
printer. 

Operator 
Notification

Specifies the types of events for which you want to receive 
notification. For example, you can set up the server to send 
you a pop-up message whenever the amount of free disk 
space drops below 1MB. 
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New File System Memory option
In LANtastic 8.0, the General Server Attributes module of the 
Server Control Panel includes a new File System Memory option. 
This option allows you to load the file system components of the 
LANtastic SERVER program into EMS or XMS expanded memory, 
thus saving conventional memory for DOS, application programs 
and other uses. Here are your file system memory choices:

Controlling LANtastic server speed __________________
The LANtastic Server Speed Console allows you to quickly change the 
amount of time a server dedicates to processing network requests 
before it returns to doing local tasks. This is similar to setting the 
Background CPU Usage value in the Server Performance Module 
except you can change the setting without restarting the server. 

1. From the LANtastic program group in Windows Program 
Manager, choose the LANtastic Server Speed icon. The 
LANtastic Server Speed Console appears.

Conventional This is the default memory setting, which you should retain if this server isn’t 
using the Maximum Open Files, Cached Resources and Internal SHARE 
features of the Server program.

EMS (paged) You can choose this option if this server is using one or more of the Maximum 
Open Files, Cached Resources or Internal SHARE features and you want to 
save conventional memory. To use this option you need to have an EMS 
memory manager version 3.2 or above, such as EMM386.EXE.

EMS (copied) If you’re having trouble with the EMS (paged) option above, you can choose 
this option in its place – although you’ll sacrifice some speed. To use this 
option you need to have an EMS memory manager version 4.0, such as 
EMM386.EXE. 

XMS If you don’t have an EMS driver, you can choose this option in place of one of 
the EMS options above. To use this option you need to have an XMS memory 
manager, such as HIMEM.SYS. 

SEE ONLINE HELP…

To view detailed How 
Do I? instructions for 
setting up your server, 
search under “Setting 
the Server Startup 
Parameters” in the 
LANtastic Network 
Manager online Help. 
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2. Move the button on the horizontal scale by dragging it with 
your mouse or pressing the arrow keys until the desired value 
is displayed in the box in the bottom of the console.

Hint… To automatically set the server speed each time Windows is 
launched, drag the Server Speed icon into your Windows startup 
group.

Working with control directories______________________
Control directories are used to store all of the accounts, resources 
and server startup parameters that you create using the Network 
Manager program. When you change one of those settings, you’re 
editing the control directory.

In most cases a server has only one network control directory – the 
default LANTASTI.NET. But LANtastic gives you the option of 
creating multiple control directories on your hard disk. This means 
you can have more than one network configuration saved. You can 
then switch control directories whenever your current network 
situation warrants. 

The LANtastic Network Manager online Help tells you all about 
control directories. Search for these topics: “Creating a New Control 
Directory,” “Selecting a Control Directory,” “Deleting a Control 
Directory,” “Backing up a Control Directory,” “Restoring a Control 
Directory,” “Resetting a Control Directory,” “Password-Protecting a 
Control Directory,” “Changing a Control Directory Password” and 
“Disabling Password Protection for a Control Directory.”

Using audit trails ____________________________________
Audit trails enhance security by providing a log of what server disk 
drives and printers have been accessed by network users and what 
types of access were allowed or denied. With audit trails you can:

■ See how many users are making simultaneous requests to a 
server. This can help you set appropriate values for several 
server startup parameters. 

■ Determine how well you’ve distributed the network workload 
among your servers. 

■ Keep records for billing if you charge for network services.
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WARNING! While auditing is a powerful feature, if it’s used improperly it can 
slow down server performance. To avoid this, carefully select the 
types of user activity you want audited. It’s also important to 
regularly clear and delete old audit trails. 

Setting up an audit trail
1. From the LANtastic Network Manager window, choose Server. 

The LANtastic Server Control Panel appears.

2. Make sure the Server Auditing module is located in the 
Configured Modules list. If it isn’t, drag it into this list. 

3. Click the Server Auditing icon. A window appears with 
various auditing options. For a descriptive listing of these 
options, search for “Server Auditing Settings” in the LANtastic 
Network Manager online Help.

4. Enable the types of activities you want audited. 

5. Exit Windows, then press Ctrl+Alt+Del at the DOS prompt. In 
the screen that appears, make sure there are no open 
network files and press S.

Viewing the audit trail file
1. From the LANtastic Network Manager window, choose Audit 

Trail. You’ll see a window similar to the one shown.

Hint… To make the Audit Trail window easier to read, choose from four 
font options under the Display menu. 

2. View the Audit Trail window. For a descriptive listing of its 
fields, search for “Audit Trail Window Fields Explained” in the 
LANtastic Network Manager online Help.

3. After you’re finished viewing the window, open the File menu 
and click Exit. 
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Copying, saving and clearing the audit trail
The Copy option lets you copy any portion of the audit trail file and 
paste it into any application that supports the Windows clipboard. 
To do this, select the desired portion of the audit trail and choose 
Edit, then choose Copy. Paste the audit trail text from the clipboard 
into the desired window.

The Save As File option lets you copy the audit trail to a file, then 
delete the original audit trail. To do this, choose File, then choose 
Save As File. Enter the name of the file to which you’d like to copy 
the audit trail and click OK.

The Clear Audit Trail option lets you delete all entries from the audit 
trail. To do this, choose File, then choose Clear Audit Trail and click 
Yes. Note that this option deletes ALL the entries. 

Viewing the Server Management window_____________
The LANtastic Net program’s Server Management window lets you 
monitor user activity on a server, as well as data throughput, 
status information and performance statistics.

Updating a window
By default the Server Management window and all of its associated 
windows update themselves every five seconds. If you’d like to 
change this rate or update a window immediately, choose the 
Update Rate option from the Options menu. Using the mouse or 
arrow keys, move the box on the Update Rate scale to the desired 
setting and click OK. To update a window immediately, choose 
Options, then choose Update Now. 

Viewing the User Statistics window
1. From the LANtastic Net window, choose Manage. If you’re 

prompted to select a server or if you’d like to specify a 
different server, click the Computers button and select a 
computer, as described in Chapter 2. (If the computer you 
want to connect to isn’t on the list, click the Connections 
button and proceed as described in Chapter 2.) 

2. View the User Statistics window, which is similar to the one 
shown. For descriptions of its fields, search for “Viewing the 
User Statistics Window” in the LANtastic Net online Help.
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3. When you’re finished, click Close.

Viewing the other windows
1. From the LANtastic Net window, choose Manage. If you’re 

prompted to select a server or if you’d like to specify a 
different server, refer to step 1 on page 42. 

2. From the User Statistics window, open the View menu and 
choose Throughput Statistics, Status Information or 
Performance Statistics. For a description of the fields in each 
window, search for “Viewing the [windowname] Window” in 
the LANtastic Net online Help.

Flushing a server’s caches ___________________________
If you have the S (System Manager) privilege, you can cause a 
server to clear and update its account and resource information. If 
the LANcache program is running, you can save its information to 
disk. Search for “Flushing a Server’s Caches” in the LANtastic Net 
online Help.

Controlling a remote server _________________________
LANtastic lets you control another server’s keyboard from your 
local computer. This is useful if you want to issue a command on 
a server and see the results on your own screen. Search for 
“Controlling a Remote Server” in the LANtastic Net online Help.
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Using a spooled keyboard resource
A spooled keyboard resource allows you to send a batch file of 
commands to a remote server. The server then executes these 
commands locally. You can even specify the time at which the 
spooled commands will be executed. 

During software installation, the Setup program created the default 
@BATCH spooled keyboard resource for you. But if you’ve deleted 
this resource, you’ll have to create another one. Search for 
“Creating Keyboard and Screen Resources” in the LANtastic 
Network Manager online Help.

Shutting down a remote server_______________________
If you have the S (System Manager) privilege, you can shut down 
and/or reboot a remote server without leaving your desk. Users 
who are logged in to the server can receive notice of the pending 
shutdown so they can save their work and close any open files. You 
can specify the number of minutes before the shutdown and 
customize the pop-up notification that you send. For instructions, 
see “Shutting Down a Remote Server” in the LANtastic Net online 
Help.

If you think other people may be using the server you want to shut 
down, you can log one or more of them out, or even prevent further 
logins. Search for “Logging a User Out of a Server” and “Disabling 
Logins to a Server” in the LANtastic Net online Help.

Once you’ve scheduled a shutdown, you can cancel it as long as the 
amount of time specified in the Computer Shutdown window hasn’t 
expired. Search for “Canceling a Server Shutdown” in the LANtastic 
Net online Help.

WARNING! Remotely shutting down a server that’s running an application 
under Windows may cause lockups and unpredictable behavior. 
Don’t schedule a shutdown unless you can exit any application 
running on that computer before the shutdown occurs.
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Sending a pop-up message__________________________
LANtastic for DOS, Windows 3.x, Windows 95/98 and Windows NT 
users can send each other single-line pop-up messages. 
Procedures differ slightly in each interface, as explained in their 
respective user’s manuals.

Important… Before you complete the steps in this section, make sure the NET 
MESSAGE command is enabled on all computers to which you want 
to send a message. To determine if it is, type NET SHOW at the DOS 
prompt. If you see “Unsolicited messages will BEEP, POP-UP and 
SPEAK,” you know that the NET MESSAGE command is enabled. 
If it isn’t, type NET MESSAGE/ENABLE ALL at the DOS prompt.

To send a pop-up message from LANtastic for Windows, complete 
these steps:

1. From the pull-down menu in the LANtastic Net window, 
choose Pop-Up Messages. The Pop-Up Messages window 
appears. For a description of the options in this window, see 
“Options in the Pop-up Messages Window” in the LANtastic 
Net online Help.

2. Type the name of the destination computer in the Send To 
field. To send a message to all users on the network, type in 
the wildcard character “*”. To send a message to a group of 
users, type in the group name followed by “*”. 

3. Type your message (up to 79 characters) in the Message field.

4. Click the Send button. 

SEE ONLINE HELP…

For more detailed 
instructions on 
managing your 
servers, see the 
LANtastic Net and 
Network Manager 
online Help. 
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Chapter 8

MANAGING PRINTING

Using the Print Jobs window
Chapter 3 explains how to view and control jobs in the LANtastic 
Net Print Jobs window. For other activities that you can perform 
from that window, search for the following topics in the LANtastic 
Net online Help: “Creating a Print Item Using the Text Editor,” 
“Printing from the Print Jobs Window,” “Delayed Printing,” 
“Controlling Multiple Printers,” and “Creating and Controlling 
Logical Printer Streams.” 

Using other print control functions___________________
LANtastic provides print control functions in places other than the 
Print Jobs window. For example:

The Printing and Despooling module in the Server Control Panel 
provides options that allow you to improve printer performance. 
You can also enable or disable many despooling and automatic 
disk-space-saving functions. For an overview of this module, see 
Chapter 7. For a descriptive listing of its options, search for 
“Printing and Despooling Settings” in the LANtastic Network 
Manager online Help.

The printer initialization strings and files functions in LANtastic Network 
Manager are useful when you want to print a job with unique 
specifications. For an overview of these functions, see page 34. For 
full setup instructions, search for “Using the Printer Setup String” 
and “Using Setup and Cleanup Files” in the LANtastic Network 
Manager online Help.

The LANtastic Remote Printer Server program, RPS.EXE, in LANtastic for 
DOS lets you share a printer connected to a client without setting it 
up as a file server. After your RPS setup is complete, go to the 
Server Control Panel window and toggle the Remote Print Server 
Support option to Enabled. For instructions on setting up and 
using RPS, see Mngprt_d.pdf in the Online Library.

Additional print control functions are discussed in the rest of this 
chapter.
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Controlling printing speed ___________________________ 
The LANtastic Printer Speed Console lets you set the amount of 
CPU time that a server will dedicate to printing. This allows you to 
increase the speed of printing while running Windows, or you can 
lower the setting to provide more CPU time for local applications. 
For example, if a person has a large file to print and you’ll be away 
from your desk, you can increase the CPS (characters per second) 
rate to help speed printing. When you return, you can set a lower 
CPS so your local applications such as Word for Windows or Excel 
will run faster.

Note… The LANtastic Printer Speed setting overrides any Characters Per 
Second values set for your individual resources. See Chapter 6 for 
more information on setting parameters for shared printer 
resources.

1. From the LANtastic program group in Windows Program 
Manager, click the LANtastic Printer Speed icon. The 
LANtastic Printer Speed Console appears.

2. Move the button on the horizontal scale by dragging it with 
your mouse or pressing the arrow keys until the desired CPS 
(characters per second) speed is displayed in the box in the 
bottom of the window.

3. Press Alt+F4 to exit the screen. Print jobs will now be sent to 
the printer through Windows at the speed set in step 2.

Hint… To automatically use the printer speed settings made with the 
LANtastic Printer Speed Console whenever you run Windows, 
drag the LANtastic Printer Speed icon into the Windows Startup 
group.

Important… If you have a printer server that runs for days at a time without 
shutting down, go to the Server Control Panel’s Printing 
Parameters Module and toggle the Periodic Server Queue 
Maintenance option to Enabled. The next time the server runs, it 
will start periodically rebuilding its control file to save disk space 
and improve performance.
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Using multiple printers on one server ________________
If a server has more than one printer attached, LANtastic can 
simultaneously send jobs to each of them. To use this feature, you 
must first set up each printer as a shared resource as described in 
Chapter 6. You can also set up each printer to print in various 
modes. Each print mode can then be set up as a separate network 
resource. 

To use simultaneous despooling, make sure you allow a printer 
task for each printer on the server. For instructions on specifying 
the number of printer tasks, search for “Printing and Despooling 
Settings” in the LANtastic Network Manager online Help.

Enabling print notification __________________________
You can use the Print Notification option in LANtastic Net to send 
yourself a print notification message. When the option is active 
(checked), LANtastic will beep and send you a message whenever a 
job has finished printing.

Another type of print notification is available from the Operator 
Notification module in the Server Control Panel. If you toggle the 
Print Job Start and Print Job Finish options to Enabled, users with 
the O (Operator) privilege will receive a pop-up message when a 
print job starts and ends. For more information, see “Printing and 
Despooling Settings” in the LANtastic Network Manager online 
Help. 

Setting the printer timeout__________________________
The LANtastic Net program allows you to specify the length of time 
that LANtastic will wait to close print jobs after print characters 
have stopped coming. A confirming beep informs you when the 
print job has been closed. You may choose a timeout period from 
zero to an hour, but ten seconds (the default value set in 
STARTNET.BAT) is usually adequate. 

1. From the LANtastic Net window, open the Net menu and 
choose Set Printer Timeout. 

2. Type in a timeout value from 0 to 3600 seconds and click OK. 
The timeout value specified will be used until you reboot the 
computer or specify a new timeout value.
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Using despooling options ____________________________
LANtastic offers several options for enhanced despooling speed and 
efficiency. For example, you can:

■ Move the printer spool area. This is a good idea if you’d like to 
use a larger or faster disk for despooling. Search for “Moving 
the Printer Spool Area” in the LANtastic Network Manager 
online Help.

■ Clear the entire spool area without deleting each entry 
individually. Search for “Clearing the Spool Area” in the 
LANtastic Network Manager online Help.

■ Set up immediate despooling, so a server can immediately 
begin to despool and print a job before all the information 
has been written to its disk. The job will print faster because 
you don’t have to wait for it to be completely written from a 
network computer before printing begins. Search for “Setting 
Up Immediate Despooling” in the LANtastic Network 
Manager online Help. 

SEE ONLINE HELP…

For more detailed 
instructions on 
managing your 
printing operations, 
see the LANtastic Net 
and Network 
Manager online Help. 
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Chapter 9

EXPANDING AND CHANGING YOUR 
NETWORK

Adding or removing a network user__________________
If everyone is automatically logging in to all servers with no 
restrictions, you can add or delete a user without taking any action 
at all. The user simply starts or stops using the network. 

If adding a new user requires a server to allow more than ten users 
at the same time, complete the instructions in the next section. In 
a network that uses security, you’ll also have to add or delete 
accounts and resources.

Increasing the maximum number of users ____________
After the LANtastic software is installed, each of your servers lets 
up to ten people use its drives and printers at once. If you want a 
server to allow more people to use it at the same time:

1. From the LANtastic Network Manager window, choose Server. 
The Select Control Directory window appears. 

2. Select the control directory you want to modify and click OK. 
The Select Loadable Server window appears. 

3. Specify the full path to the directory containing the 
SERVER.EXE file that you’ll use with the control directory 
you’re modifying. Click OK. The LANtastic Server Control 
Panel appears. 

4. Click the General Server Attributes icon in the Configured 
Modules field. In the Maximum Number of Users field of the 
dialog box, type in the number of simultaneous users that 
you want this server to allow. Click OK, then exit Windows. 

5. Press Ctrl+Alt+Del, then press the S key. To restart your 
system, press Ctrl+Alt+Del again. 
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Note… To obtain faster response time on a server that has many 
simultaneous users, you may also want to increase the Network 
Task Buffer Size and Maximum Concurrent Network Tasks 
parameters in the LANtastic Server Control Panel’s Server 
Performance module. 

Adding or removing a computer______________________

To add a computer after LANtastic is installed:

1. Install a network adapter in your new computer. 

2. Turn off all network computers and cable the new computer 
to your network according to the instructions in your adapter 
documentation.

3. Install the LANtastic software on the new computer. (If 
desired, use the single-disk add-on installation described in 
the LANtastic Installation and Setup Manual.)

4. Go to each computer that will regularly use the new 
computer’s disk drive and make a new permanent drive 
connection. 

5. If appropriate, take one or more of these steps:

■ If the new computer is a server and you want to allow more 
than ten users at one time, increase the maximum 
number of users.

■ If the new computer is a server with more than one printer 
attached, create a shared printer resource and increase 
the number of printer tasks. 

■ If the new computer is a server and you want to set it up 
with account and resource security features, use the 
LANtastic Network Manager program to do so.

To physically disconnect a computer:

1. Turn off all your network computers, then disconnect the 
network cable from the computer you want to remove. If you 
have coaxial cable, attach the cable to the next computer – 
and if the computer you removed was an end node, move the 
terminator to the new end node.

2. Turn on the remaining network computers.

3. If the computer you just removed was a server, go to each 
computer that has been using its disk drives and printers. 
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Use a text editor such as Windows Notepad to edit its 
STARTNET.BAT file. Delete the NET LOGIN and NET USE 
command lines for the server you just removed. Save the 
changes to the STARTNET.BAT file, and exit the editor. 

4. At the DOS prompt, type SETNET <Enter> to update drive and 
printer connection information in your CONNECT.BAT file.

5. From the LANtastic Net window, choose Computers. If the 
computer you removed is still on the list of those you’re 
connected to, select it and click Disconnect. Then pull down 
the Options menu and choose Save Settings Now. 

6. Reboot this computer.

7. Repeat steps 3 – 6 for each computer that has been using the 
server you disconnected. 

To temporarily remove a computer from the network:

1. Use a text editor such as Windows Notepad to open the 
AUTOEXEC.BAT file. 

2. Remove or comment out the STARTNET command from the 
AUTOEXEC.BAT file.

3. Save the changes and exit the editor.

4. Reboot the computer. To put the computer back in the 
network, add the STARTNET command to the 
AUTOEXEC.BAT file.

Note… This computer and its resources won’t be available to the network. 
Any NET LOGIN or NET USE commands that reference this computer 
should be removed from all batch files on other computers, or 
commented out of their STARTNET.BAT files until the computer is 
reinstalled on the network. 

Changing a computer’s name or sharing status________
To change the name of a network computer:

1. Use a text editor such as Windows Notepad to open the 
STARTNET.BAT file. 

2. Change the computer name in the REDIR line and any other 
lines where the name appears. 

3. Save the changes and exit the editor. 
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4. Make sure the STARTNET.BAT files at any other computers 
with connections to the renamed computer are edited to 
reflect the new name. 

To change a client to a server:

1. Reinstall the LANtastic software. Make sure that there’s a 
check mark in the box next to “Do you want to share this 
Computer’s Drives and Printers?”

2. Tell your co-workers the new server’s computer name, so they 
can begin to make connections to its drives and printers.

To change a server to a client:

1. Use a text editor such as Windows Notepad to open the 
server’s STARTNET.BAT file. 

2. Remove the SERVER command.

3. Save the changes and exit the editor.

4. Reboot the computer. It now will operate as a client only and 
cannot share its resources.

Note… Any NET LOGIN or NET USE commands that reference this computer 
should be removed from all batch files on other computers. 

Adding a CD-ROM drive _____________________________
1. Install the CD-ROM drive and support software as instructed 

in the manufacturer’s manual. 

2. Use a text editor such as Windows Notepad to open the 
server’s STARTNET.BAT file (in the LANTASTI directory). 

3. Add the command that executes the CD-ROM software.
This is an example:

MSCDEX.EXE /D:MSCD004/L:F 

To find the exact command you need to use, refer to your 
CD-ROM drive documentation.

4. Delete the command that executes the CD-ROM software 
from your AUTOEXEC.BAT or CONFIG.SYS file.

5. Set up the CD-ROM drive as a shared resource. For 
instructions, search for “Creating a CD-ROM or Other 
Non-DOS Drive Resource” in the LANtastic Network Manager 
online Help.
LANTASTIC FOR WINDOWS 3.X USER’S MANUAL



55
Adding or removing a printer _______________________  

To add a printer after LANtastic has been installed:

1. Connect it to a server as instructed in your printer manual. 

2. If the server hasn’t yet been set up for network printing, do so 
according to the instructions that follow.

3. Set up the printer as a shared resource.

4. Go to each computer that will regularly use the new printer 
and make a new permanent printer connection. 

5. If the server has more than one printer attached, or if the new 
printer is attached to a port other than LPT1, follow the 
instructions under “To increase the number of printer tasks” 
on page 55.

To set up a server to support network printing:

1. At the LANtastic Network Manager window, choose Server. 
The Select Control Directory window appears. 

2. Select the control directory you want to modify and click OK. 
The Select Loadable Server window appears. 

3. Specify the full path to the directory containing the 
SERVER.EXE file that you’ll use with the control directory 
you’re modifying. Click OK. The LANtastic Server Control 
Panel appears. 

4. Drag the Printing and Despooling icon from the Available 
Modules list into the Configured Modules list. 

5. Create a shared printer resource for the server’s printer.

6. Exit Windows. Press Ctrl+Alt+Del, then press the S key. To 
restart your system, press Ctrl+Alt+Del again. 

To increase the number of printer tasks:

WARNING! Increasing the number of printer tasks may slow down local 
processing of the computer during printing. However, you must do 
this in order to print simultaneously on two or more printers that 
are connected to the same server.

1. Go to the server with multiple printers. From the LANtastic 
Network Manager window, choose Server. The Select Loadable 
Server window appears.
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2. Specify the full path to the directory containing the 
SERVER.EXE file that you’ll use with the control directory 
you’re modifying. Click OK. The LANtastic Server Control 
Panel appears. 

3. Make sure that the icon for the Printing and Despooling 
module is in the Configured Modules list. If it isn’t, drag it 
there.

4. Double-click the Printing and Despooling icon in the 
Configured Modules list. In the Maximum Active Printer 
Tasks field in the dialog box, type in the number of printers 
attached to this server. Click OK. 

5. Exit Windows. 

6. Press Ctrl+Alt+Del, then press the S key. To restart your 
system, press Ctrl+Alt+Del again. 

7. Run your LANtastic software.

To add an HP JetDirect printer:

To do this, you must first set up a resource for the HP JetDirect 
printer and make some configuration changes on a server in your 
network. Complete steps appear in the LANtastic Installation and 
Setup Manual.

To temporarily remove a printer:

1. From the LANtastic Net window, choose Printers. The Printer 
Connections window appears. 

2. In the My Connections list, select the printer you want to 
remove, then click Disconnect. Click Close.

To permanently remove a printer:

1. On each computer that uses this printer, use a text editor 
such as Windows Notepad to open the STARTNET.BAT or 
CONNECT.BAT file in the C:\LANTASTI directory. 

2. Remove the NET USE command for the server’s printer from 
the STARTNET.BAT or CONNECT.BAT file. The command will 
look similar to this: NET USE LPT1 \\OFFICE_SERVER\@PRINTER.

3. Save the changes to the STARTNET.BAT or CONNECT.BAT 
file and exit the editor. 
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4. Reboot the computer.

5. Repeat these steps on each computer that has been using the 
printer you’ve removed.

Note… If the printer connection reappears, look for additional connection 
information in the C:\WINDOWS directory, in the files WIN.INI, 
WNET.INI, and WINFILE.INI. Delete the pertinent printer 
connection line from those files and reboot your computer.

Improving server performance and memory use ______
For normal network use, LANtastic’s default server configurations 
provide good network throughput and response times. However, if 
your network is exceptionally large or bears a lot of traffic, you may 
want to fine-tune some elements. For example:

The Server Control Panel lets you optimize your memory usage by 
loading only the modules that you need. For example, if a server 
isn’t sharing a printer, you can disable all the printing modules.

The File System Memory option in the Server Control Panel allows you 
to load the file system components of the LANtastic Server program 
into EMS or XMS expanded memory, thus saving conventional 
memory for DOS, application programs and other uses.

The Server Personality List in the Server Control Panel lets you choose 
preset options for print and file servers. In many cases, using these 
pre-sets can significantly enhance server performance.

The Server Speed Console allows you to quickly change the amount 
of time the server dedicates to processing network requests before 
it returns to doing local tasks. 

The LANcache disk-caching utility can improve the performance of a 
file server. For instructions, see the file called Lcach_dw.pdf in the 
LANtastic 8.0 Online Library. 

LANtastic’s DOS-based ALONE program can increase the speed of a 
dedicated file or print server. For instructions, see your LANtastic 
for DOS User’s Manual. 

The Characters per Second option in the LANtastic Network Manager 
Resource Parameters window lets you control printing speed. 
CHAPTER 9. EXPANDING AND CHANGING YOUR NETWORK



58
The SIZE= and BUFFERS= REDIR switches can speed up client access to 
a file server. Instructions appear in the file called Cmmd_dw.pdf in 
the LANtastic Online Library.

The AILANBIO switches in your STARTNET.BAT file can increase the 
speed at which clients can access a server. Instructions appear in 
the file named Cmmd_dw.pdf in the LANtastic Online Library. 

SEE ONLINE HELP…

For more detailed 
instructions on 
managing, 
expanding, changing 
and improving your 
network, see the 
LANtastic Net and 
Network Manager 
online Help.
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